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Document Version Notes 

This document is updated from time to time as the US Army Corps of Engineers (Corps) may update 

the HEC-HMS modeling program or new discoveries regarding the model are made. Not all graphics 

are updated and some screen capture graphic from previous HEC-HMS versions are still shown and 

may not match the current version. 

 

We have found minor software issues with HEC-HMS Version 4.1 and recommend using  

HEC-HMS Version 4.2.1. 

 

Contra Costa County cannot be held responsible for changes in the Corps model that are 

inconsistent with this guidance document. See disclaimer section for more information.  
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Disclaimer  
The instructions and tips provided in this document should not be understood to be official 

instructions or training  for becoming proficient with, or an expert in, the 5ƛǎǘǊƛŎǘΩǎ ƳŜǘƘƻŘs or the 

use of HEC-HMS. The District has not written this document to ensure that the reader and user of 

ǘƘƛǎ ŘƻŎǳƳŜƴǘΩs instructions in 5ƛǎǘǊƛŎǘΩǎ ƳŜǘƘƻŘs or HEC-HMS become competent in their use.  

The Template Model (Template) referred to in this document was created by the District for use 

with the HEC-HMS modeling program. It was created for your convenience. The District has taken 

care to make it useful and accurate. However, it is possible the District has entered data into the 

Template incorrectly or has set, or chosen, settings or options incorrectly. Therefore, the District 

does not warrant or guarantee the information or data in this document or the Template to be 

correct, accurate, and complete, or without defect or error.  

The reader and user of this document and/or the Template should use his or her own judgment to 

review and correct the instructions and the Template including model inputs, settings, and results if 

and where needed. It is the responsibility of the engineer using the Template to confirm that the 

data in the model is accurate and without error as received and as modified. 

The user of the Template is also directed to the ŘƛǎŎƭŀƛƳŜǊ ƛƴ ǘƘŜ ά5ŜǎŎǊƛǇǘƛƻƴέ ŦƛŜƭŘ ƻŦ ǘƘŜ ¢ŜƳǇƭŀǘŜ 

ŀƴŘ ǘƘŜ άTerms of Conditions of use for HEC-HMSέ in the U.S. Army Corps of Engineers manuals. 

Document Update Summary  
This document was updated on the date shown on the cover and footer. By quick review, spelling, 

typing, and grammar errors were corrected. Some of the guidance tips were updated. The 

document was not thoroughly reviewed. 

The current preferred version of HEC-HMS is version  v4.2.1. It is stable in the Windows 7 operating 

system. The screen shots and directions provided herein are based on HEC-HMS v3.3 and later. The 

basic functionality of HEC-HMS in the various version is the same, however, some the graphical user 

interface (GUI) for v4.2.1 and higher is different from v3.3 and later and the screen shots provided 

herein should still provide enough continuity with v4.2.1 that they are applicable. We will likely 

update this document in the future to address important changes in HEC-HMS version. 
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Abbreviations  
The following are key abbreviations used in this document: 

¶ HEC US Army Corps of Engineers Hydraulic Engineering Center 

¶ HEC-HMS or HMS HEC Hydrologic Modeling System computer software developed by HEC 

¶ District Contra Costa County Flood Control and Water Conservation district 

¶ HEC-DSS or DSS  Data Storage System  

¶ DSS-Vue Hydrologic Engineering Center Data Storage System Viewer computer 
software developed by HEC 

 

 

 

MB:  

  

\ \PW-DATA\grpdata\ fldctl\Hydrology\Hydrology Standards\Working Versions to combine all\2018-
03-06 HEC-HMS Guidance for CCCo.docx 
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Introduction  
For many years the Contra Cost Flood Control and Water Conservation District (District) has used 

several internally developed programs to perform hydrology calculations. These programs were 

ǿǊƛǘǘŜƴ ƛƴ Chw¢w!bΦ ¢ƘŜ 5ƛǎǘǊƛŎǘΩǎ I¸5whс ǇǊƻƎǊŀƳ ran in a DOS mode on the Windows 32-bit 

platform for input and produced unit hydrographs and flood hydrographs on screen and in an 

output text ŦƛƭŜΦ ¢ƘŜ 5ƛǎǘǊƛŎǘΩǎ I¸5whн ǇǊƻƎǊŀƳ ran using an input file with unit hydrographs 

produced by HYDRO6 and/or also hydrographs entered in the input file. HYDRO2 was used for 

complex watershed models including multiple watersheds and on-line or off-line detention basins. 

However, these programs were ƭƛƳƛǘŜŘ ǘƻ ƻƴƭȅ ǘƘŜ 5ƛǎǘǊƛŎǘΩǎ ƳŜǘƘƻŘ ŀƴŘ did not have a Windows 

graphical users interface. 

In the past, anyone wanting a hydrograph for use in a flood study had to request the hydrograph 

from District staff. They then could use the District provided unit and storm hydrographs in other 

programs (HEC-1, HEC-HMS, Mouse, MIKE11, or other hydrology software) to perform more 

complex watershed hydrology analyses. 

In an effort to find a replacement for its proprietary programs, District staff has verified most of the 

standard data needed for HEC-HMS modeling. These include rainfall distribution curves, the S-curve 

(a.k.a. percentage curve) used for the unit hydrograph method, and the lag equation. Other 

standards staff are still verifying are watershed N-values, infiltration rates, and methods used in 

measuring or calculating specific parameters for the hydrology calculations. ¢ƘŜ 5ƛǎǘǊƛŎǘΩǎ IȅŘǊƻƭƻƎȅ 

Section will continue to review these standards and provide guidance to the public. With limits in 

man-power and budget, this process has become a long term process. 

Comparisons of the HEC-HMS model and HYDRO6 have revealed some subtle differences between 

the two models and some minor problems with HYDRO6. APPENDIX A.      presents those 

differences and problems. The transition to HEC-HMS has addressed those problems. 
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Overview  

Guidance Document  
This document describes how to use HEC-HMS to model a watershed and produce the same results 

one would get from using HYDRO6. The purpose is to be concise and yet complete. This document is 

not intended to explain all aspects of HEC-HMS or the DistrictΩǎ method. This document also 

includes guidance on using a Template model put together by the District, tips, and other 

information that may be helpful to the readers who are not familiar with HEC-HMS. 

Template  HEC-HMS Model  
The HMS Template Model is available for downlƻŀŘ ŦǊƻƳ ǘƘŜ 5ƛǎǘǊƛŎǘΩǎ ǿŜōsite1 and has the 

5ƛǎǘǊƛŎǘΩǎ standard rainfall distribution curves, and S-curve in it as well as a single watershed set up 

to run. In essence, the data for the standards curves mentioned in this guidance document are 

included in the Template model and do not have to be manually input if you start a project with the 

Template model.  

The District created this Template model for several purposes: 

1. To simplify the building of an HEC-HMS model ŦƻǊ ǘƘŜ 5ƛǎǘǊƛŎǘΩǎ ƳŜǘƘƻŘǎ. 

2. To provide a clear starting point for modelers with accurate standard curves. 

3. Reduce the time to review the HEC-HMS models by assuring the standard curves were 

input correctly.  

We recommend that you download and open the Template model and follow it as you go through 

this guidance document. The Template model will not match the figures in this document perfectly, 

but using them together should increase your understanding of how a HEC-HMS model is put 

ǘƻƎŜǘƘŜǊ ŦƻǊ ǳǎƛƴƎ ǘƘŜ 5ƛǎǘǊƛŎǘΩǎ ƳŜǘƘƻŘΦ 

                                                           
1
 Go to http://www.contracosta.ca.gov/5745/Documents-and-Standards ŀƴŘ ŎƭƛŎƪ ƻƴ άIȅŘǊƻƎǊŀǇƘ {ǘŀƴŘŀǊŘǎέ ƛƴ ǘƘŜ ƭŜŦǘ 

sidebar. 

http://www.contracosta.ca.gov/5745/Documents-and-Standards
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Building a HEC-HMS Model   
A model in HEC-HMS2 is made by starting HEC-HMS and creating a new project. The following is a list 

of steps for setting up an HEC-HMS model. 

hƴ ǘƘŜ ά/ƻƳǇƻƴŜƴǘǎέ ǘŀō: 

¶ A Basin Model is created with subbasins and other elements needed for the model. The 
subbasin characteristics are entered into to the Basin Model. 

¶ Control Specifications are created to define the date and time for which the model is to be 
run. The rainfall time series start and end times (time frame) must fall within the Control 
Specification time frame. 

¶ Time Series data is entered including rainfall patterns and known hydrographs if any. 

¶ Paired Data is input to define the S-curve, and if needed, detention basin stage-storage and 
stage-discharge relationships as well as a storage-discharge relationship.  

¶ A Meteorologic Model is set up. This assigns the rainfall time series data and storm rainfall 
depths to the watersheds in the Basin Model for various storms.  

 
hƴ ǘƘŜ ά/ƻƳǇǳǘŜέ ǘŀō: 

¶ The model runs (simulations) are set up as combinations of Basin Models, Meteorologic 
Models, and Control Specifications. 

¶ This allows many combinations of different model parts to run various scenario simulations. 
That is, a Basin Model can be run using several different Meteorologic Models and Control 
Specifications. 

 
hƴ ǘƘŜ άwŜǎǳƭǘǎέ ǘŀō: 

¶ The results of each simulation are organized in the Results tab in the same order that the 
simulations are organized on the Compute tab.  

¶ From the Results tab you can view the results in graphical and tabular form. 

Input and Results in DSSVue 

The results of the HEC-HMS models, as well as the input curves and time series data, are saved in 

Data Storage System (DSS) files. This makes them easily transportable to other HEC models. The DSS 

files can be viewed in HEC-HMS, but the user may find it easier to view the data using HEC-DSSVue3 

and from there copied and pasted or exported to other formats such as Excel. 

The sections that follow provide more details for building a basic HEC-HMS model with screen and 

menu shots provided for clarification. HEC-DSSVue guidance is not provided in this document. 

Template Model Content  

The Template model contains all of the basic time series data and paired data related to the 

5ƛǎǘǊƛŎǘΩǎ ǎǘŀƴŘŀǊŘǎ ŀƴŘ was set up to follow naming conventions suggested in this guidance. Though 

                                                           
2
 The HEC-HMS (Hydrologic Engineering Center - Hydrologic Modeling System) program is available for download without 

charge at http://www.hec.usace.army.mil/software/hec-hms/. This document is based on version 3.3. 
3
 Hydrologic Engineering Center Data Storage System Viewer (HEC-DSSVue) program is available for download without 

charge at http://www.hec.usace.army.mil/software/hec-dssvue/.  

http://www.hec.usace.army.mil/software/hec-hms/
http://www.hec.usace.army.mil/software/hec-dssvue/
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this guidance describes steps to set up a model, you can skip many of these steps by using the 

Template.  
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Project Creation  

After starting HEC-HMS, choose File/New. In the dialogue box, enter a descriptive name for the HEC-

HMS project, selŜŎǘ ǘƘŜ ƭƻŎŀǘƛƻƴ ŦƻǊ ǘƘŜ ƳƻŘŜƭΩǎ ŦƛƭŜǎ, and choose U.S. Customary units. Click 

ά/ǊŜŀǘŜέΦ 

After creating the project, the HEC-HMS window (Figure 1) will show a folder with the project name, 

the description, and the location of the DSS file for the project. The HEC-HMS program stores time 

series and pared data as well as the model results in the DSS file. 

This is a good time to set the defaults for the model. Go to the top HEC-HMS menu bar and click 

Tools > Program Settings. We like to set the following defaults on the Default tab as follows:  

¶ Unit system:   U.S. Customary  

¶ Subbasin Surface: Simple Surface 

¶ Subbasin loss:   Initial and Constant4 

¶ Subbasin transform: User-Specified S-Graph 

¶ Subbasin baseflow: Recession 

¶ Reach Routing:  Muskingum-Cunge 

¶ Subbasin precipitation:  Specified Hyetograph 

If the defaults are not set, they can be changed at other 

places in the model. Establishing the defaults early saves 

time and avoids mistakes. 

If you download and use the Template model from the 

District website, many of these steps can be skipped. 

  

                                                           
4
 This is the simplest method to use. You may also use the Soil Moisture Accounting Method and the Deficit and Constant 

Method. See APPENDIX K.     for instructions on each of the methods. 
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Figure 1  HEC-HMS Project Creation Example 
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Component Creation  
Using the Components menu (see image to right) and 

ǘƘŜ άƳŀƴŀƎŜǊǎέ ǳƴŘŜǊ ƛǘΣ ȅƻǳ Ƴǳǎǘ ŎǊŜŀǘŜ ŀǘ ƭŜŀǎǘ ƻƴŜ ƻŦ 

each of the following for a model using ǘƘŜ 5ƛǎǘǊƛŎǘΩǎ 

method: 

¶ Basin Model, 

¶ Meteorologic Model, 

¶ Control Specifications,  

¶ Time-Series, and 

¶ Paired Data.  

Basin Model Manager  
Using the Basin Model Manager, create a basin. Name it 

what you want and enter a description as needed. The 

Basin Model will contain subbasins (watersheds) and 

other elements such as reaches, junctions, and detention 

basins. You will often have more than one Basin Model 

such as the pre-project and the post-project model. You 

can copy a Basin Model, so it is helpful to build one of the 

Basin Models and then copy it and modify the copy to 

make the other Basin Models. 

Do the same with the Meteorologic Model Manager, and 

Control Specifications Manager. These managers do not 

have options other than creating and naming components. The components are edited later to add 

model specific information. 

Time Series Manager 
Using the Time Series Manager create a time series 

for a design storm. In the image to the right, a 

precipitation gage is defined for the 3-hour rainfall 

distribution curve. The actual data for the curve will 

be input later. Notice the name we use ƛǎ άло Ƙέ ŀƴŘ 

ƴƻǘ άо ƘέΦ HEC-HMS sorts the components 

alphanumericallyΦ .ȅ ƛƴŎƭǳŘƛƴƎ ŀ άлέ ƛƴ ŦǊƻƴǘ ƻŦ ǘƘŜ 

άоέΣ ǘƘŜ άло Ƙέ ŎǳǊǾŜ ǿƛƭƭ be listed ōŜŦƻǊŜ άлс Ƙέ ŀƴŘ 

άмн Ƙέ ƛƴ the list of precipitation gauges. In addition, 

ǳǎƛƴƎ ǘƘŜ άƘέ ƛƴǎǘŜŀŘ ƻŦ ǘƘŜ ǿƻǊŘ άƘƻǳǊέ ǎŀǾŜǎ 

typing time and space in table and plot labels later 

on.  
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This convention is a District preference. We have learned that this practice of naming the 

components aids in organization, management, and review of the models. 

Paired Data Manager  
Using the Paired Data Manager create a percent 

pattern. In the image to the right, we have selected 

άtŜǊŎŜƴǘage Curveέ ŦƻǊ ǘƘŜ {-curve we will input 

later. The paired data manager is where placeholders 

are created for stage-storage curves, stage-discharge 

curves, etc. Any paired data that is not associated 

with time is entered using this manager.  

 

 

 

Folder View after Creating Components  
In the image to the right, we have expanded the 

άŦƻƭŘŜǊǎέ ŦƻǊ the entire HEC-HMS model and exposed all 

of the components created using the Component 

Managers. 

These are the basic components needed to run a model 

using the 5ƛǎǘǊƛŎǘΩǎ method. Beyond this, you can create 

more Basin Models (with multiple subbasins, detention 

basins, junctions, diversions, sinks), Meteorologic 

Models, Control Specifications, Precipitation Gages and 

other paired data. 

A good practice would be to set up a basic model like 

this, including the standard rainfall distribution curves 

and S-curve and save it as a template for future 

modeling work. This will save time and assure 

consistency. Later in this document, we present such a 

Template we have created for use in Contra Costa 

County. 
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Data Entry  
The data entry order is important in that some 

elements depend on data from others. For example, 

for the District method, each subbasin needs the S-

curve data for its transformation method and the 

Meteorologic Models need the precipitation gage 

data. Below, we describe an order of data entry that 

inputs data in a logical order to reduce having to go 

back and forth between model elements and data 

entry. 

Paired Data  
Because the Basin Model requires the selection of the S-Curve, you should enter it first. Paired data 

consists of both X and Y values. The 5ƛǎǘǊƛŎǘΩǎ S-curve has 840 X-Y values and is not provided in this 

document. It is included in the Template model and is also available in electronic format from the 

District websiteΦ {ŜŀǊŎƘ ŦƻǊ ŦƻǊ ŀ ŘƻǿƴƭƻŀŘŀōƭŜ ŦƛƭŜ ǳƴŘŜǊ ά{-/ǳǊǾŜ ƛƴ Ȅƭǎ ŦƻǊƳŀǘέ at: 

http://www.cccounty.us/5747/Hydrology-Standards.  

By clicking on the S-curve component created earlier, three tabs are shownΦ ¢ƘŜ άaŀƴǳŀƭ 9ƴǘǊȅέ 

option shown ŦƻǊ ά5ŀǘŀ {ƻǳǊŎŜέ on the Paired Data tab in the image above is correct. 

Note: This S-curve data is 

included in the Template 

model and can also be 

obtained in an .xls file 

online. 

http://www.cccounty.us/5747/Hydrology-Standards
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 = Subbasin Creation Tool 

 

The paired data entry forms have Table and Graph tabs for data entry and graphical review. For the 

basic model (a model without detention basins, diversion, etc.) the S-curve is the only paired data 

ǊŜǉǳƛǊŜŘ ŦƻǊ ǘƘŜ 5ƛǎǘǊƛŎǘΩǎ ƳƻŘŜƭƛƴƎ ƳŜǘƘƻŘΦ Other paired data include stage-storage and stage-

discharge curve for detention basins. 

Basin Model  
You can model many subbasins 

(watersheds) in a Basin Model. You can 

create detention basins, define junctions 

and diversions, join hydrographs at 

junctions, and use routing methods to 

estimate the attenuation of flow down 

creeks. You can perform many other 

hydrologic tasks. However, at its basic 

level, the basin model needs at least one 

subbasin. The example that follows 

includes only one subbasin.  

Basin Units 

The units used in the modeling should be 

consistent with your project. We use the 

U.S. Customary units in Contra Costa 

County. The units on the subbasin should be checked to 

make sure they match what you are using in your 

project. 

When you select the basin icon, the lower portion of the 

window shows basin information. Find the ά¦ƴƛǘ {ȅǎǘŜƳέ 

line and select the correct units for your basin using this 

window. If you set this as the program default as 

mentioned above, it should already be correct. 

Subbasin Creation  

In the image to the right, we have created a 

subbasin by clicking on the Subbasin Creation 

Tool (icon defined above right), clicking in the 

ά.ŀǎƛƴ aƻŘŜƭ ώ.ŀǎƛƴ мϐέ ǿƛƴŘƻǿ (map like), 

ŜƴǘŜǊƛƴƎ ǘƘŜ ƴŀƳŜ άPreέ ŀƴŘ ŎƭƛŎƪƛƴƎ ά/ǊŜŀǘŜέΦ In 

the image, we have ŜȄǇŀƴŘŜŘ ǘƘŜ ά.ŀǎƛƴ мέ 

basin folder and the Pre subbasin folder to 

reveal other parts of the subbasin element.  
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Subbasin Parameters  

When you click on the subbasin in the folder view, (or on the 

map using the arrow tool), the lower part of the HEC-HMS 

window shows tabs related to the subbasin (see image at right). 

The first tab is the Subbasin tab. A Description can be entered. 

You enter the Area under this tab. For the 5ƛǎǘǊƛŎǘΩǎ method use 

the following options: 

¶ Surface Method = Simple Surface 

¶ Loss Method = Initial and Constant (APPENDIX K.     

discusses other options). 

¶ Transform Method = User-Specified S-Graph  

¶ Baseflow Method = Recession. 

When you change these options in the Subbasin tab, the 

options on the Surface, Loss, Transform, and Baseflow tabs 

also change. Setting these options as defaults under the 

Tools>Project Options menu saves time in larger projects that 

have multiple basins. 

Clicking on the Loss tab reveals that the Soil Moisture 

Accounting method has numerous fields for input. For the 

5ƛǎǘǊƛŎǘΩǎ ƳŜǘƘƻŘΥ  

¶ All the fields must ōŜ ǎŜǘ ǘƻ άлέΣ ŜȄŎŜǇǘ ŦƻǊ ǘǿƻΤ 

otherwise, the model will not run.  

¶ Surface Storage = 0.25 inches  

¶ Max Infiltration = the constant infiltration, which varies 

with land use is input here. 

The Surface tab should have Initial Storage=0 and Max 

{ǘƻǊŀƎŜҐлΦнрέΦ  όǎŜŜ ƛmage to right) 

The Loss tab should have all values = 0 except Max Infiltration 

should be equal to the watershed infiltration rate for the 

watershed.  (see image to right) 

 

The Transform tab is where you choose the S-Graph (aka S-curve) for the Subbasin. The Lag Time is 

unique to each subbasin. Calculation of the 5ƛǎǘǊƛŎǘΩǎ Lag Time is described in APPENDIX D.     . 
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 The 5ƛǎǘǊƛŎǘΩǎ Baseflow standard is a constant 5.0 

cubic feet per second per square mile (cfs/sq. mi.). 

The settings are: 

¶ Initial Type = Discharge Per Area  

¶ Initial Discharge = 5 cfs/sq. mi. 

¶ Recession Constant = 1 

¶ Threshold Type = Threshold Discharge 

¶ Flow  = 0 CFS 

The Options tab is explained in APPENDIX G.      
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Time Series Data 
For the DistrictΩǎ method, time series data consists 

primarily of precipitation data input for the rainfall 

distribution curves. The Meteorologic Model will provide 

the option of Total Override that must ōŜ ǎŜǘ ǘƻ άȅŜǎέΦ 

This option causes the total storm rainfall depth entered 

into the Meteorologic Model to be distributed over time 

in the same pattern as input in the time series for the 

precipitation gage.   

The image to the right shows the 03 h Precipitation Gage 

we create earlier and the Time-Series Gage tab visible in 

the lower window. The 5ƛǎǘǊƛŎǘΩǎ ƳŜǘƘƻŘ requires: 

¶ Data source = άaŀƴǳŀƭ 9ƴǘǊȅέ  

¶ Units = άLƴŎǊŜƳŜƴǘŀƭ LƴŎƘŜǎέ 

¶ Time interval = (dependent on rainfall 

distribution curve. See APPENDIX B.     ). 

The 5ƛǎǘǊƛŎǘΩǎ standard data comes in 15 minute, 30 

minute or 2 hour time intervals. The 15-minute time 

interval is correct for the 5ƛǎǘǊƛŎǘΩǎ standard 3-hour storm 

rainfall distribution we will input to this gage in our 

example. 

After clicking the plus sign next to the time 

series and selecting the άǘƛƳŜ ǿƛƴŘƻǿέ below 

ǘƘŜ άло Ƙέ ƛŎƻƴΣ ȅƻǳ ǿƛƭƭ ǎee other tabs appear. 

In the Time Window tab, change the start and 

end date and time for the rainfall data. Use the 

ddMMMYYYY format as shown. 

IMPORTANT: The time series time and date 

must be within the Control Specifications 

Component time and date you will create 

later. 

The HEC-HMS default is likely different from 

what was input for Control Specifications or 

any other time series you may have entered. 

Change the start date and time to be the same 

as the modeling period you want to use. Enter 

an end time so that it is at or beyond the time 
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of the end of your gage data. 

For the 3-hour curve, you can set the time and date as 

shown in the image on the previous page. (NOTE: 

When you input data, the text changes to the color 

blue. They turn black when you save). 

 The DisǘǊƛŎǘΩǎ о-hour 

rainfall distribution curve 

is shown at the right. This 

is put into the Table tab 

ƻŦ ǘƘŜ άлоƘέ ¢ƛƳŜ-Series 

Gage. This and other 

district rainfall 

distribution curves are 

provided in APPENDIX B.     

. 

The date and time on this 

tab reflect the Time 

Window tab settings. The 

5ƛǎǘǊƛŎǘΩǎ ǎǘŀƴŘŀǊŘ ǊŀƛƴŦŀƭƭ 

distribution curves are available in its standards 

document and in electronic format5 and can be 

copied and pasted into the HEC-HMS time series 

tables.  

Note that the rainfall input starts at the start 

of second time interval. 

If a gage is used in a model run with a Control 

Specifications with a different time frame than the 

gage, HEC-HMS will create a different time window 

under the Time Series Gage. Though this may clutter 

the folder view, it does not alter the Precipitation Gage 

data. Time windows can be deleted using the right click 

menu options. Be sure that the remaining time 

windows contain all of the precipitation gage data and 

make sense as part of your model. The precipitation 

data can be visually checked via the Graph tab.  

                                                           
5
 ¢ƘŜ ǊŀƛƴŦŀƭƭ ŘƛǎǘǊƛōǳǘƛƻƴ ŎǳǊǾŜǎ ŀǊŜ ŜƴǘŜǊŜŘ ƛƴǘƻ ǘƘŜ ¢ŜƳǇƭŀǘŜ ƳƻŘŜƭ ǘƘŀǘ ƛǎ ŀǾŀƛƭŀōƭŜ ƻƴ ǘƘŜ 5ƛǎǘǊƛŎǘΩǎ ǿŜōǎƛǘŜ ŀǘ 

http://www.cccounty.us/5746/Hydrograph-Standards. They are also available via 
http://www.cccounty.us/5747/Hydrology-Standards.  

3-hour Rainfall 
Distribution Curve 
(15 mIn intervals) 

3.0 

2.0 

5.0 

2.8 

8.8 

10.2 

5.5 

7.0 

10.5 

11.0 

27.7 

6.5 

 

The precipitation time series data for the 

3-, 6-, 12-, 24, and 96-hour storms are 

included in the Template model. 

http://www.cccounty.us/5746/Hydrograph-Standards
http://www.cccounty.us/5747/Hydrology-Standards
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Meteorologic Model   
The Meteorologic Model assigns the storm rainfall 

to the subbasins. For the 5ƛǎǘǊƛŎǘΩǎ method, we use 

it to apply the rainfall pattern and total design 

storm rainfall amount to the subbasins. Click the 

Meteorologic Model and look at the tabs in the 

lower left portion of the HEC-HMS window.  

The Meteorologic Model should look like the image 

to the right (except for the model name): 

¶ Precipitation = Specified Hyetograph 

Evapotranspiration and Snow Melt = None 

¶ Units System = U.S. Customary. 

If you are working with only one basin model, you 

do not need to duplicate the basin model for each 

design storm. You simply need to create a 

Meteorologic Model for each design storm. Then 

use each of them with the same basin model in 

different simulation runs. 

¸ƻǳ Ƴŀȅ ƘŀǾŜ άǇǊŜέ ŀƴŘ άǇƻǎǘέ ŎƻƴŘƛǘƛƻƴǎ ƳƻŘŜƭǎΦ 

You would need different basin models for these 

because the subbasins would have different 

characteristics. 

On the Basins tab, the basins that the Meteorologic 

Model ǿƛƭƭ ŀǇǇƭȅ ǘƻ ǎƘƻǳƭŘ ƘŀǾŜ ά¸Ŝǎέ ǎŜƭŜŎǘŜŘ ōȅ 

their names. This indicates that this Meteorologic 

Model can be used with these basins. The reason 

for this option is that there are times when you 

would want to ǇǊŜǾŜƴǘ ǘƘŜ άŀŎŎƛŘŜƴǘŀƭέ ǳǎe of a 

Meteorologic Model with a specific Basin Model. 

On the Options tab, the Total Override should be 

set ǘƻ ά¸ŜǎέΦ ¢Ƙƛǎ ǘŜƭƭǎ ǘƘŜ Meteorologic Model to 

replace the precipitation gage total with the storm 

total (to be entered later). In effect, this makes the 

precipitation gage a rainfall distribution pattern 

because it overrides the rainfall depth in the precipitation gage with storm total for the subbasin. If 

you ŎƘƻƻǎŜ άƴƻέ ŦƻǊ ǘƘƛs option, you would have to scale the precipitation gage data to equal the 

rainfall depths or each time step. The override = yes option greatly simplifies the modeling effort. 


























































































